Tired of jumping through hoops to set up PTO?
Accrual Plan Structure

In Oracle HRMS, accrual plans are based on elements, formulas, and a net accrual calculation. All of these are available for you to configure so you have complete control over the rules underlying your plans. Oracle HRMS does not store net accrual totals. It calculates gross accruals dynamically by calling the Accrual formula. The net accrual calculation specifies the element entries that should add to or subtract from this figure to create the net entitlement.

If you use Oracle Payroll, you can set up your accrual plan so that gross accruals are stored in a payroll balance. Each payroll run retrieves the latest balance and calls the accrual formula to calculate new accruals since the end of the last payroll period. This approach – using a payroll balance – is optional but provides performance enhancements if you need to calculate accruals in a batch process.
Almost Everything you Wanted to Know about PTO - Paid Time Off

Accrual Balances Maintained By the Payroll Run

If you use Oracle Payroll, you can choose to use a payroll balance to store gross accruals for an accrual plan. You do this by selecting a balance dimension (such as calendar year to date) when you define the accrual plan. The system then automatically generates the balance and other components you require.

Why Use a Payroll Balance?

Some batch processes, such as the US Check Writer, call the accrual formula to calculate PTO accruals for each assignment. If you use such processes, you will benefit from faster batch processing if you set up your accrual plan to use a payroll balance. This reduces the number of calculations the formula has to perform.

How The Balance Is Maintained

Payroll Run ➔ calls the Payroll Formula (database item) ➔ calls the Accrual Formula ➔ that makes an entry to the Balance Element ➔ Feeding the Payroll Balance

The payroll run maintains the payroll balance. When the payroll run processes an accrual plan element entry, it calls an Oracle Payroll formula associated with the accrual plan element.

This formula calls your accrual formula to calculate the gross accrual, passing in the following information:

• The name of the database item for the payroll balance, so the accrual formula can retrieve the number of days or hours currently in the payroll balance

• Date to begin calculating new accruals, which is the day after either the Date Earned or the Date Paid of the last payroll period in which the assignment was processed

You can choose whether the formula uses Date Paid or Date Earned by selecting the Payroll Balance Type for your business group in the Organization window.

Date Earned is the date the payroll run uses to determine which element entries to process. In North America (and typically elsewhere too) it is the last day of the payroll period being processed.

Date Paid is the date that appears on pay advices. The payroll run uses this date to select taxation rules, and store balances. In some legislations, these dates are always the same.

• Calculation date, which is either the date earned or the date paid of the payroll run

The accrual formula returns the new gross accrual to an element that feeds the balance. So normally the formula only has to calculate accruals since the last payroll run, and add this value to the existing payroll balance. However, if the accrual formula finds absences entered retrospectively, it recalculates accruals for the whole year. This is to ensure that the employee receives their full accrual entitlement.
Step 1: **For Time Card Required = N(Must be an Information Element):**

Navigation Path > Total Compensation > Basic > Element Description

Complete the following fields:

1. **Name** = The Name of the Element
2. **Reporting Name** = Then name that will print on the checks/deposit advices
3. **Classification** = Information
4. **Type** = Non-Recurring
5. **Termination** = In this example I have chosen Final Close *
6. Multiple Entries will default to being checked (this is OK)
7. Process in Run will default to being checked (this is OK) / Save

**Notes:**

*The Termination Rule on this element (taken element) defaults to the Accrual Plan (associated). For Example: if the customer chooses Final Termination, they should change the Accrual Plan to Actual Termination, if not the Accrual Plan will continue to accrue in accordance with the End Employment form. i.e. if the Final Process Date is left blank the plan will keep accruing.*
Almost Everything you Wanted to Know about PTO - Paid Time Off

Process in Run - (Note: If this is an absence element for a PTO Accrual Plan, DO NOT SELECT Process In Run. Uncheck this box if necessary.)

Step 2: Open the Further Information FlexField

Complete the following fields:

1. **Category** = Absence Hours

Save
Step 3: Go to Input Values

Complete the following fields:

1. **Name** = Enter any name you want such as Hours
2. **Units** = Hours in Decimal format (2 places))

Notes:

Ensure that there are at a minimum the following two input values are listed:

1. Units type of Date
2. Units type of Hours (must be in Hours in Decimal format (2 places))

As a rule, always add (or verify) these to Inputs to be able to add additional element/s to the NCR (Net Calculation Rules) on the Accrual Plan form

SAVE
Step 1: **For Time Card Required = Y (Must be an Earnings Element)**

Navigation Path > Total Compensation > Basic > Earnings

Complete the following fields:

1. **Name** = The Name of the Element
2. **Reporting Name** = Then name that will print on the checks/deposit advices
3. **Classification** = Earnings
4. **Category** = Regular Non-Worked
5. **Calculation Rule** = HOURS_X_RATE_MULTIPLE_NONRECUR_V2
6. **Type** = Non-Recurring
7. **Termination** = Actual Termination *

Save

**Notes**

*The Termination Rule on this element defaults to the Accrual Plan (associated). For Example: if the customer chooses Final Termination, they should change the Accrual Plan to Actual Termination, if not the Accrual Plan will continue to accrue in accordance with the End Employment form. i.e. if the Final Process Date is left blank the plan with keep accruing.*
Step 2: Navigation Path > Total Compensation > Basic > Element Description

Complete the following fields:

1. **Multiple Entries Allowed** = Verify that the box ‘is’ checked
2. **Process in Run** = HR Only users this field can be blank, for Payroll users this box should be checked
3. **Save**

Step 3: Open the Further Information FlexField
Almost Everything you Wanted to Know about PTO - Paid Time Off

Complete the following fields:

**Override Regular** = Select from LOV Yes, but in the field you will see T
When using an Earning PTO taken element, the element must have the segment 'Override Regular' set to YES. If set to 'No' then the PTO taken element will not override the Regular Salary/Regular Wages element.

If an upgrade customer, the segment may be named PAYMIX CATEGORY if this is the name, the value will be Time+
Earnings must be set to Regular in order for the correct values to display in the Override Regular LOV.

**Reduce Regular** = No - If this element being used for timecard required employees only,
if you checked this box (which means Yes, Reduce Regular) it will decrease the Regular Wages by the amount of vacation taken).
The other fields are optional for the customer to enter

Save

Step 4: Click on Input Values:
Notes:

Ensure that at a minimum the following two input values are listed:
1. Units type of Date
2. Units type of Hours (must be in Hours in Decimal format (2 places))

As a rule, always add (or verify) these to Inputs to be able to add additional element/s to the NCR (Net Calculation Rules) on the Accrual Plan form

SAVE
Step 5: Create Link for this element

Navigation Path > Total Compensation > Basic > Link

Complete the following fields:

1. Click on Save for a global link or check the Link to All Payrolls box / save
2. *Customers can create specific if needed, however they may have problems when the criteria changes

Notes

*Generally, Oracle recommends that customers use open links for PTO because of complications. Typically, PTO generates the open links automatically, which goes some way in preventing this problem:
For Example: If the link criteria is based on assignment category and the person's assignment category changes on the 15th Jan, the person's link eligibility switches from one link to another. This automatically end-dates the persons existing PTO element on the 15th Jan and creates a new element, linked to the new link, from the 16th Jan. Technically, this has the same affect as removing the person from one accrual plan and putting them on another.

With the current PTO functionality, there is no mechanism to transfer accruals from one plan to another. So if an employee leave Plan A in the middle of the year and join Plan B they lose all the year's accruals for plan A. To correct the customer would have to create an adjustment element, and add to the NCR (Net Calculation Rules) on the Accrual Plan.

The links would be the same on both an Earnings and Information Elements!
Step 6: Create Absence (OPTIONAL)

Navigation Path > Total Compensation > Basic > Absence Type

This step may be skipped if PTO is not entered using the absence form. Meaning end users only enter through Batch Element Entry (BEE)

Enter the following fields

**Name** = Absence for TimeCard Req _Yes

**Category** = Vacation (Absence_Category must be V)

To verify this, with the cursor in the Category field - go to Help > Diagnostics > Examine.

**Block** = ABT

**Field** = ABSENCE_CATEGORY

**VALUE** = This should have a 'V' listed

Associated Element

Name = XXX_Vac_Taken_Eam, Select the element you are using to record PTO (step 1)

Input Value = Hours (or Days)

Units = Hours (or Days)

Balance = Increasing

Enter Reasons if you want to use them / SAVE
Why am I picking Increasing?

Increasing Balances of Time Taken

As you would expect, an increasing balance for an absence type starts with no time entered, and increases as you enter employees’ hours or days absent. For example, if the absence type Compassionate Leave has an increasing balance, the balance starts from zero for each employee and increases by the number of hours entered for each absence of this type. Increasing balances are appropriate for most absence types. For absence types for which your enterprise sets a maximum time allowed, the system issues a message when an entry of time absent exceeds this maximum, or Oracle Alert can notify you when an employee reaches the maximum time or takes excess time. See: Oracle Alert User’s Guide

When defining an absence type for a PTO accrual plan, you give it an increasing balance that shows the employee’s accrued time taken. When you record an absence using the Absence Detail window, you can see the amount of accrued time a plan participant has available for use as vacation or sick leave.

Decreasing Balances of Time Remaining

If your enterprise sets a maximum time allowed for an absence type that is not connected to a PTO accrual plan, you have the option of setting up a decreasing balance for this type, instead of an increasing balance. For example, suppose your enterprise allows certain employees 32 hours leave per year for professional development. The Professional Leave absence type can have a decreasing balance, and an initial entry of 32 hours. If you record an employee absence of 4 hours for this absence type, the decreasing balance shows 28 hours still available to be taken. Decreasing absence balances require more maintenance than increasing balances. They need a prorated initial balance entry for all eligible new hires throughout the year, and require resetting each year for all eligible employees. Notice that an absence type cannot have both a decreasing and an increasing balance; it has one or the other.
Step 7: Total Compensation > Basic > Accrual Plans

To Setup the PTO Accrual Plan (Based on a Calendar Year)

Enter the following ‘REQUIRED’ information:

- **Plan Name** = XXX_Vacation_Plan
- **Accrual Category** = Vacation
- **Accrual Start** = Hire Date

Some plans do no read the Accrual Start value – This rule determines the date on which newly hired employees begin to accrue PTO. Currently only the PTO_PAYROLL_BALANCE_CALCULATION & PTO_PAYROLL_CALCULATION use this value

*(If you select Beginning of year – be advised, this means the Beginning of the Year ‘FOLLOWING’ the Hire Date)*

- **Accrual Units** = Select Hours or Days – based on the ‘taken’ elements Input Values (controls what elements are displayed on the LOV in the Absence Information block)

- **Accrual Formulas**
  - **Accrual Formula Name** = PTO_PAYROLL_BALANCE_CALCULATION

If customers are using Oracle Payroll it is recommended that they use one of the formulas with the word ‘Balance’ in it. These formulas are written with the new balance architecture and should be used for accurate balances on checks & deposit advices. (as well as faster processing time)

If customers are HR Only they should use the formulas ‘WITHOUT’ the word balance
**Almost Everything you Wanted to Know about PTO - Paid Time Off**

- **Carryover Formula Name** = PTO_PAYROLL_CARRYOVER
  Payroll Formula = Automatically populated when you’ve selected a Balance Reset Date other than no Balance when you Save the record

- **Absence Information**
  - **Name** = XXX_Vac_Taken_Earning
    (element was created in step 1)
  - **Units** = Hours

- **Payroll Balance Reset Date**

  **Balance Reset Date** = If using the seeded formula as in the example of PTO_PAYROLL_BALANCE_CALCULATION then you must select 01 January as this is how that formula is written

  However, this is not a hard Jan 1- Dec 31 – It’s based on the payroll dates

- **Dimension Name**: Automatically assigned based on the PTO Balance Type field

  **Note**: Where does the Balance Dimension Name on the Accrual Plan come from when I select a Balance Reset Date?
  Navigation: Work Structures > Organization > Description > Query up the appropriate Organization > In the Organization Classification select Business Group > Click the 'Others' button > Select PTO Balance Type

  This designates how the gross accrual plan balances will be stored - either on Dated Earned (Pay Period End Date) or Date Paid (Check Date). The default is Date Paid. The payroll run maintains the payroll balance. It calculates accruals from the day after either the Date Earned or the Date Paid of the last payroll period in which the assignment was processed

  When you add an Accrual plan and click a Balance Reset Date (that is not No Balance) a Dimension is assigned based on the PTO Balance Type setting:

  When using the Balance Type 'Date Paid' _ASG_PTO_YTD will be the Balance Dimension
  When using the Balance Type 'Date Earned' _ASG_PTO_DE_YTD will be the Balance Dimension

  SAVE when completed
Generated Elements

The system generates the following elements when you save a new accrual plan:

- An element representing the plan and which has the same name as the plan. You use this element to enroll participants in the plan.

- An element to hold participants' unused PTO that is available for carry over to the next year.

- An element to hold residual PTO, that is, unused PTO not available for carry over under plan rules.

If you use Oracle Payroll and have elected to store gross accruals in a payroll balance, the system also generates:

- An element to feed a payroll balance. This element receives an entry from the accrual formula during a payroll run.

- A tagging element, which the payroll run uses to keep track of retrospective absences (and other element entries included in the net accrual calculation) that need to be included in the gross accrual calculation.

The Carried Over and Residual elements have input values that automatically receive entries when you run the PTO Carry Over process:

- Hours or Days (depending on the plan’s units)

- Effective Date

- Expiry Date (on the Carry Over element), which is the date by which the employee must use the carried over time.

Oracle HRMS automatically links these elements using the same link criteria that you created for the absence element associated with the plan. If you change the links for the absence element, you should also update the links for the other plan elements.
How To Set Up An Accrual Plan To Use a Balance

If you want the payroll run to maintain an accrual balance, you must use a formula that supports balances. This means that the system can pass the latest accrual balance to the formula, along with the date to start calculating new accruals to add to the balance.

You can use or configure one of the following seeded formulas:

• PTO_HD_ANNIVERSARY_BALANCE
• PTO_PAYROLL_BALANCE_CALCULATION
• PTO_SIMPLE_BALANCE_MULTIPLIER

You must also select a balance dimension when you define the accrual plan. The balance dimension controls the period of time over which the balance accumulates before it is reset to zero. Three types of dimension are predefined:

Note: For each type, there are two dimensions. Use the Date Earned dimension (such as _ASG_PTO_DE_YTD) if you selected Date Earned as the PTO Balance Type for your business group. Otherwise use the Date Paid dimension (such as _ASG_PTO_YTD).

See: Business Groups: Selecting a PTO Balance Type, Using Oracle HRMS—The Fundamentals

• _ASG_PTO_YTD and _ASG_PTO_DE_YTD
  The balance accumulates over a calendar year, resetting on 01 January. Select one of these dimensions if you are using the PTO_PAYROLL_BALANCE_CALCULATION formula.

• _ASG_PTO_SM_YTD and _ASG_PTO_DE_SM_YTD. The balance accumulates over a year, resetting on 01 June, or at the end of the payroll period that contains this date. Select one of these dimensions if you are using the PTO_SIMPLE_BALANCE_MULTIPLIER formula.

• _ASG_PTO_HD_YTD and _ASG_PTO_DE_HD_YTD
  The balance accumulates over a year, resetting on the anniversary of the employee’s hire date, or at the end of the payroll period that contains this date. Select one of these dimensions if you are using the PTO_HD_ANNIVERSARY_BALANCE formula.

If you require your balance to accumulate over a different period of time, or reset at a different date, you must create your own balance dimension. For further information on balance dimensions, see the technical essay “Balances in Oracle Payroll” in Implementing Oracle HRMS.

Notice that the Oracle Payroll formula, payroll balance, element that feeds the balance, element link, and formula processing and result rules are all generated by the system when you save your accrual plan.
Accrual Bands

If using the `PTO_PAYROLL_BALANCE_CALCULATION` or `PTO_PAYROLL_CALCULATION` enter band information based on your policy (this could be days or hours depending on your set-up)

**Years of Service** = Enter appropriate ranges for the accrual amounts for business

**Annual Rate** = Enter total hours or days given for the year

**Maximum Carryover** = Enter the Maximum amount the employee can carryover at year end

**Ceiling** = Enter the maximum amount of vacation ITD the employee can have

Save

Close Form
Step 7b: To add additional elements to an Accrual Plan select Net Calculation Rules:

The Net Calculation formula requires input of hours as well as the date that the PTO plan becomes effective. That means that any element associated with PTO plans must have two input values - one with Units type of Hours and one with Units type of Date. If both input values are not present, the element will not show in the list of values because the user will not be able to enter the necessary information for processing without them.

If the element is not showing up in the LOV on this form, check the following:

1. Check the element definition for the element that is not showing up on the list of values.
2. Ensure that there are at least two input values; one with Unit type of Date and one with Unit type of Hours. (must be Hours in 2 decimal places)
3. Check the Link to Element to ensure Element is “Linked”
4. If an Earnings Element verify the Override Regular DFF is populated (See page 9)
About Formula’s:

Accrual Formulas

Most accrual plan rules are incorporated in two formulas:
• An Accrual formula, which calculates the amount of PTO accrued at any given time, and
• A Carry Over formula, which returns the maximum amount of accrued time that a plan
  participant can carry over to the next plan period, the date on which this carry over is effective
  (normally the first day of the new accrual term), and any expiry date by which the carried over
  PTO must be used, or forfeited.

Seeded Accrual Type Formulas

There are four seeded formulas (of formula type Accrual) for calculating accruals. Each
repeatedly calls another formula (of type Accrual Subformula), in a loop, to calculate the accrual
for each accrual period. There is a Carry Over formula supplied to use with each Accrual formula.
The top level seeded Accrual formulas are:

• PTO_PAYROLL_BALANCE_CALCULATION
• PTO_SIMPLE_BALANCE_MULTIPLIER
• PTO_ROLLING_ACCRUAL
• PTO_HD_ANNIVERSARY_BALANCE

The formulas with “Balance” in their names can be called from the payroll run to maintain a
balance of gross accruals

Note:
There are also two seeded formulas called PTO_PAYROLL_CALCULATION and
PTO_SIMPLE_MULTIPLIER. These incorporate the same rules as
PTO_PAYROLL_BALANCE_CALCULATION and PTO_SIMPLE_BALANCE_MULTIPLIER,
except that they cannot be called from the payroll run to maintain a balance of gross accruals. We
recommend that you use the formulas that support balances so you can use balances now or in
the future.
Ineligibility Formula

There is also a seeded Ineligibility formula:

• PTO_INELIGIBILITY_CALCULATION

You may require an Ineligibility formula if you use BEE (Batch Element Entry) to enter absences against an accrual plan. BEE validation must ascertain whether an employee is eligible to use accrued PTO on the effective date of an absence entry in a batch line. First it checks the Accrual Plan table, so if you enter the period of ineligibility in the Accrual Plan window, you do not need to create an Ineligibility formula.

If there is no ineligibility information in this table, BEE validation checks whether there is an Ineligibility formula to call. You need an Ineligibility formula if you use BEE and you calculate the period of ineligibility within your Accrual formula, rather than entering it in the Accrual Plan window. This formula is only used by BEE.

Note: If you use the seeded formulas, you do not need an Ineligibility formula, because these formulas take the ineligibility period from the Accrual Plan table.

Description of Seeded Accrual Formulas

PTO_PAYROLL_BALANCE_CALCULATION

This formula calculates accruals in the same way as the accrual function in earlier releases of Oracle HRMS. It calls another formula that is called PTO_PAYROLL_PERIOD_ACCRUAL. It is designed to be used with the Carry Over formula PTO_PAYROLL_CARRYOVER. These formulas are based on the following rules:

• An accrual term of one calendar year, starting 1 Jan. So, accrual calculations restart at the beginning of each calendar year.

• An accrual frequency based on the participant’s pay periods. So, employees on a monthly payroll accrue time each month, employees on semi–monthly payrolls accrue time twice each month, and so on. PTO accrual occurs automatically for each eligible plan participant on the last day of his or her pay period, independently of any payroll run.

• Accrual amounts and ceiling are determined by length of service.

• Carry over is always effective on 31 Dec of the plan year being processed. So, if you run the Carry Over process and specify the parameters ‘15 January 2000’ and ‘Previous’ (plan year), The formula calculates the carry over for the year 1 Jan to 31 Dec 1999 and the result has the effective date 31 Dec 1999.

• Carry over expires at the end of the plan year. So carried over time with the effective date 31 Dec 1999 must be used before 31 Dec 2000.

• Maximum carryover depends on length of service bands.
PTO_SIMPLE_BALANCE_MULTIPLIER

This is a simple formula to provide a useful starting point for your own accrual plans. It calls another formula, called PTO_SIMPLE_PERIOD_ACCRUAL. It is designed to be used with the Carry Over formula PTO_SIMPLE_CARRYOVER.

These formulas are based on the following rules:

• An accrual term of one calendar year, starting 1 June. So, accrual calculations restart at the beginning of each June.

• An accrual frequency of one month.

• Accrual amounts and ceiling are fixed within the formula.

• Carry over is always effective on 31 May of the plan year being processed.

• Carry over expires at the end of the plan year. So carried over time with the effective date 31 May 1999 must be used before 31 May 2000.

• Maximum carry over is fixed within the formula.

PTO_HD_ANNIVERSARY_BALANCE

This formula is very similar to PTO_SIMPLE_BALANCE_MULTIPLIER, but the accrual start date is the anniversary of the employee assignment’s hire date.

Note: Notice that the accrual term starts on the anniversary of the hire date. It is not affected by the entry of a continuous service date for an employee on enrollment in the plan. The continuous service date affects length of service calculations (for accrual bands and calculation of period of ineligibility), but it does not affect the accrual term.

PTO_ROLLING_ACCRUAL

This is an example formula for an accrual plan that does not have a fixed term start date. It calls the formula PTO_ROLLING_PERIOD_ACCRUAL. It is designed to be used with the Carry Over formula PTO_ROLLING_CARRYOVER.

These formulas are based on the following rules:

• An accrual term of one calendar year, with no fixed start date. Accruals are calculated for the previous 12 months.

• An accrual frequency of one month.

• Accrual amounts and ceiling are fixed within the formula.

• Carry over is not relevant, since the accrual term never ends, but rolls forward. Time is lost if it is not used within 12 months.
Summary of Rules in Seeded Formulas

The following tables summarize the rules incorporated in the seeded Accrual formulas.

### Length of Accrual Term

<table>
<thead>
<tr>
<th>All Seeded Formulas</th>
<th>One year</th>
</tr>
</thead>
</table>

### Accrual Term Start Date

<table>
<thead>
<tr>
<th>PTO_PAYROLL_BALANCE_CALCULATION</th>
<th>PTO_SIMPLE_BALANCE_MULTIPLIER, PTO_HD_anniversary_Balance, and PTO_ROLLING_ACCRUAL</th>
<th>PTO_ROLLING_ACCRUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 January</td>
<td>01 June (PTO_SIMPLE_BALANCE_MULTIPLIER) Anniversary of hire date (PTO_HD_anniversary_Balance)</td>
<td>No fixed date; accruals calculated for preceding 12 months</td>
</tr>
</tbody>
</table>

### Accrual Frequency

<table>
<thead>
<tr>
<th>PTO_PAYROLL_BALANCE_CALCULATION</th>
<th>PTO_SIMPLE_BALANCE_MULTIPLIER, PTO_HD_anniversary_Balance, and PTO_ROLLING_ACCRUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll period</td>
<td>Monthly</td>
</tr>
</tbody>
</table>

### Accrual Amount

<table>
<thead>
<tr>
<th>PTO_PAYROLL_BALANCE_CALCULATION</th>
<th>PTO_SIMPLE_BALANCE_MULTIPLIER, PTO_HD_anniversary_Balance, and PTO_ROLLING_ACCRUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depends on length of service accrual bands</td>
<td>A fixed amount per month (2 days)</td>
</tr>
</tbody>
</table>

### Accrual Ceiling

<table>
<thead>
<tr>
<th>PTO_PAYROLL_BALANCE_CALCULATION</th>
<th>PTO_SIMPLE_BALANCE_MULTIPLIER, PTO_HD_anniversary_Balance, and PTO_ROLLING_ACCRUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depends on length of service accrual bands</td>
<td>Set within the formula to 20 days</td>
</tr>
</tbody>
</table>

### Length of Service

<table>
<thead>
<tr>
<th>All Seeded Formulas</th>
<th>Uses continuous service date (if present) or hire date. Note: continuous service date is entered using an input value on the accrual plan element</th>
</tr>
</thead>
</table>

### Accrual Start Date for New Hires

<table>
<thead>
<tr>
<th>PTO_PAYROLL_BALANCE_CALCULATION</th>
<th>PTO_SIMPLE_BALANCE_MULTIPLIER, PTO_HD_anniversary_Balance, and PTO_ROLLING_ACCRUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice of start rules on Accrual Plan form: hire date, or six months after hire date, or 01</td>
<td>Accrual starts in the first accrual period after hire date or plan enrollment date, whichever</td>
</tr>
</tbody>
</table>
Jan after hire date Accrual starts in the first
accrual period after the chosen date (or plan
enrollment date if this is later).

<table>
<thead>
<tr>
<th>Period of Ineligibility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Seeded Formulas</strong></td>
</tr>
</tbody>
</table>
| Accrued amounts are not credited until end of period of ineligibility (entered on Accrual Plan
form), which is calculated from the hire date (or continuous service date if this was entered). Note
that accrued amounts are not carried forward if the end of the accrual term falls
within the ineligibility period.

<table>
<thead>
<tr>
<th>Calculation of Gross Accrual</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PTO_PAYROLL_BALANCE _CALCULATION</strong></td>
</tr>
</tbody>
</table>
| Sums accruals in all full pay
periods of the year ending on
or before the calculation date;
takes account of any
employee termination date,
accrual start rules, ineligibility
period, and accrual ceiling.

| **PTO_SIMPLE_BALANCE_MULTIPLIER**
| and PTO_HD_ANNIVERSARY_BALANCE |
| Sums accruals in all full
months of the year ending on
or before the calculation date;
takes account of any
employee termination date,
ineligibility period, and accrual
ceiling.

| **PTO_ROLLING_ACCRUAL** |
| Sums accruals in the 12
months ending on or before
the calculation date;
takes account of any employee
termination date, ineligibility
period, and accrual ceiling.

<table>
<thead>
<tr>
<th>Changing and Adding Rules in Formulas</th>
</tr>
</thead>
</table>
| If you write your own formulas (perhaps using the simple multiplier or rolling accrual formula as a
basis) you can change any of these rules and add new rules as required. However, your formulas
must return certain values and must check for certain conditions (such as employee termination)
to avoid errors.

For information about required formula content, see: Writing Formulas for Accrual Plans, Using Oracle FastFormula.
For a sample accrual formula and suggestions on how to edit it to incorporate a whole range of
plan rules, see: Sample Accrual Formula, Using Oracle FastFormula.

<table>
<thead>
<tr>
<th>Accrual Start Date for New Hires</th>
</tr>
</thead>
</table>
| Using the seeded PTO_PAYROLL_BALANCE_CALCULATION formula, accrual of PTO begins
on a fixed date each year (01 January). For each plan that uses this formula, you can select a
value in the Accrual Start field of the Accrual Plan window. This specifies when newly hired
employees start to accrue PTO. The seeded choices are:

- Hire Date
- Beginning of Calendar Year after their hire date
- Six Months after Hire Date

If you need additional start rules, you can define them as values for the Lookup Type
US_ACCRUAL_START_TYPE. You must add a line to the seeded formula to calculate the
accrual start date using your new start rule.

The other seeded formulas (PTO_SIMPLE_BALANCE_MULTIPLIER,
PTO_HD_ANNIVERSARY_BALANCE, and PTO_ROLLING_ACCRUAL) do not use values in the
Accrual Start field. For plans using these formulas, new hires begin accruing on their
Almost Everything you Wanted to Know about PTO - Paid Time Off

hire date or plan enrollment date, whichever is later. If you are writing your own accrual formulas, you can choose whether to use the Accrual Start field on the Accrual Plan form to specify start rules for new hires. This is only useful if you are using the same formula for several accrual plans with different start rules. Otherwise you can specify the start rule within the formula.

Period of Ineligibility

Some accrual plans require participants to work for a period of time, perhaps three or six months, before they are eligible to use accrued PTO. They accrue time at the usual rate during this time, but it is not registered on the system until the Period of Ineligibility expires. If plan participants take vacation or sick leave during this period, the system displays a negative value for accrued time. Many enterprises set up an absence type for “approved but unpaid leave” to use for absences taken during periods of ineligibility. You can enter the period of ineligibility on the Accrual Plan form. The seeded Accrual formulas illustrate how a formula should use the entered values. They calculate the period of ineligibility from the continuous service date (if it was entered) or the employee’s hire date. Alternatively, you can define the period of ineligibility within your Accrual formula.

Note: If you use the seeded formulas, time accrued during the ineligibility period is not carried over if the end of the accrual term falls within the ineligibility period.

Batch Element Entry and the Ineligibility Period

If you want to use Batch Element Entry (BEE) to make absence entries against the accrual plan, the BEE validation process must be able to check when the ineligibility period expires.

• If you record the ineligibility period for the plan on the Accrual Plan form, BEE retrieves the ineligibility period directly from the table. It interprets it as a period of time from the employee’s continuous service date or hire date.

• If the period of ineligibility is defined within your Accrual formula, you must associate an Ineligibility formula with the plan. BEE calls the formula, which returns Y or N to indicate whether the employee is eligible to use accrued PTO on the date supplied by BEE. This formula should calculate the end of the ineligibility period in the same way as the Accrual formula for the plan. If the employee is not eligible, the BEE validation process creates a warning on the batch line for the absence entry.

Note: If you use a custom method of entering timecard data, calling the Element Entry API, you can add logic to call the Ineligibility formula.

How the Seeded PTO_PAYROLL_BALANCE_CALCULATION Formula Interprets the Start Rules

The formula calculates the start date from hire date and compares it with the employee’s plan enrollment date. Accrual begins on whichever of these two dates is later.

Start Rule: Hire Date
For plans with this rule, participants' accruals begin from the first full period following their hire date. For example, if the hire date of a participant on a semi–monthly payroll falls on the first day of either the first or second period in the month, PTO accrual starts as of that date. If the hire date falls sometime after the first of the month but before the end of the first period, accruals start in the second period of the month. If the hire date falls after the first day of the second period but before its end, accruals start with the first period in the next month.

**Start Rule: Beginning of Calendar Year**

With this start rule, participants' accruals begin from the start of the year following the year in which they are hired. This means that a participant with a hire date of 1 January 1999 and another with a hire date of 31 December 1999 both start to accrue time as of 1 January 2000. Notice that the amount of PTO each accrues may not be the same, as accrual amounts often depend on employees' length of service.

**Start Rule: Six Months After Hire**

For plans with this start rule, participants' accruals do not begin until the first full pay period after the six–month anniversary of their hire date. For example, someone on a semi–monthly payroll who is hired on 5 February 1996, completes six months of service on 5 August 1996, and starts to accrue PTO in the second period in August. Notice that if people are hired on the first day of a period, their accruals begin with the pay period of the six–month anniversary of their hire date. For example, someone on a semi–monthly payroll who is hired on 1 February 1996 completes six months of service on 1 August 1996, and hence starts to accrue PTO in the first period in August.

The period of ineligibility is not applicable to plans with the start rule Six Months After Hire.

**Accrual Bands**

For many accrual plans, the time off that plan participants can accrue increases with their length of service, or varies by job, grade, or number of hours worked. That is, *accrual bands* determine accrual amounts. In addition, these bands can determine *ceiling* and *maximum carry over* amounts. Ceiling rules, found in some vacation accrual plans, set a maximum amount of PTO an employee can hold at any time. When a participant’s accrued PTO reaches the ceiling, no additional time accrues. Accruals begin again only after the participant uses some accrued time. In the PTO_PAYROLL_BALANCE_CALCULATION seeded formula, the accrual amount, ceiling and maximum permitted carry over depend on length of service bands. Alternatively, you can use bands based on other factors, such as grade, or a combination of factors, to determine the accrual amounts for your plans.

**Length of Service Bands**

You set up length of service bands using the Accrual Bands window. For each band (such as 0 to 5 years of service), you can enter the accrual amount for the whole accrual term (such as an annual amount), an accrual ceiling, and the maximum permitted carry over.

**Length of Service Override**
In Oracle HRMS, the **first day of the month of an employee's hire date** is the default date from which his or her length of service is calculated for accrual purposes. For example, someone hired on 18 January 1997 completes one year of service on 1 January 1998, and someone hired on 31 December 1996 completes one year of service on 1 December 1997. For individual accrual plan participants, you can override the default date from which a plan starts its length of service calculations. This is useful for managing exceptional cases that arise when, for example, employees who already have accumulated periods of service in your enterprise transfer from one place to another. You enter the date override when enrolling a participant in a plan.

**Note:** The default length of service start date (or the overriding continuous service date) determines the length of service for accrual bands and for the calculating the end of the ineligibility period. However it is **not** the same as the accrual start date. This is determined by the accrual start rules selected in the Accrual Plan window or set within the accrual formula.

**Other Banding Criteria**

For some accrual plans, the amount of time accrued may vary by other criteria, such as job or grade. You can create a user table to hold time accrued, ceiling rules, maximum carryover rules, and any other information you require for each job or grade. See: User–Defined Tables, *Configuring, Reporting, and System Administration in Oracle HRMS*. Include the GET_TABLE_VALUE function in your accrual and carry over formulas for the plan to access the information held in the user table. For an example of using a user table to store banding criteria, see: Sample Accrual Formula, *Using Oracle FastFormula*. 
Helpful Notes/Documents

*Note 146721.1 - R11.5 - Setup an Earnings Type Element to be Used to Capture PTO in Oracle Time Management

*Note 148524.1 Release 11.5: How To Setup a PTO Plan and the Elements for This Plan

*Note 146702.1 Paid Time Off (PTO) Accruals And Accrual Formulas
*Note 261768.1 How Does Payroll Read the Carryover Elements Effective Date

Note 261765.1 Where is the balance for the accrual plan element stored

Note 261385.1 What does Selecting a PTO Balance Type at the Business Group do?
Note 294634.1 HRMS 11i Upgrade and PTO Process Automation

For more information I suggest printing the PTO Absence & PTO Accruals section, From the Managing Total Compensation Using Oracle HRMS (US). It’s about 60 pages, I recommend keeping this for your reference

*Recommend marking these in Web IV
Almost Everything you Wanted to Know about PTO - Paid Time Off

There are several notes on PTO – please check all possible words when you are looking for notes. Or better yet, in the SURE Query just Query on SHHARLEY.US, enter a key word to narrow the search. Hopefully this will help you a little more in your quest for answers.

Notes on CarryOver

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.263586.1</td>
<td>Ext/Pub</td>
<td>THE PTO CARRYOVER COMPLETING BUT NOT UPDATING.</td>
</tr>
<tr>
<td>Note.261494.1</td>
<td>Ext/Pub</td>
<td>Do I still run the Carryover if I'm using ITD Balances?</td>
</tr>
<tr>
<td>Note.261507.1</td>
<td>Ext/Pub</td>
<td>ORA-201 occurred at line 70 of formula PTO_PAYROLL_CARRYOVER</td>
</tr>
<tr>
<td>Note.261768.1</td>
<td>Ext/Pub</td>
<td>How Does Payroll Read the Carryover Elements Effective Date</td>
</tr>
<tr>
<td>Note.261057.1</td>
<td>Ext/Pub</td>
<td>PTO CARRYOVER RUN BUT NO CARRY OVER BALANCES CREATED</td>
</tr>
<tr>
<td>Note.263594.1</td>
<td>Ext/R.R</td>
<td>PTO CARRYOVER PROCESS DOES NOT WORK IN 1ST YEAR OF SERVICE</td>
</tr>
<tr>
<td>Note.264323.1</td>
<td>Ext/R.R</td>
<td>ORA-20001- ORA-201 occurred at line 79 of formula PTO_PAYROLL_CARRYOVER</td>
</tr>
<tr>
<td>Note.261501.1</td>
<td>Ext/Pub</td>
<td>PTO Carryover is Not Rolling over Balances</td>
</tr>
<tr>
<td>Note.260376.1</td>
<td>Ext/Pub</td>
<td>Accrual Plan Net Calculation Rules Question</td>
</tr>
<tr>
<td>Note.255865.1</td>
<td>Ext/Pub</td>
<td>Problem With Accrual Plans On Multiple Assignments</td>
</tr>
<tr>
<td>Note.262108.1</td>
<td>Ext/R.R</td>
<td>Accrual Plan did not Zero out on January 1st</td>
</tr>
<tr>
<td>Note.278419.1</td>
<td>Ext/Pub</td>
<td>How to Delete an Accrual Plan out of the system</td>
</tr>
<tr>
<td>Note.261765.1</td>
<td>Ext/Pub</td>
<td>Where is the balance for the accrual plan element stored</td>
</tr>
<tr>
<td>Note.277164.1</td>
<td>Ext/Pub</td>
<td>What Shadow Elements are Created when I 'Save' my Accrual Plan</td>
</tr>
<tr>
<td>Note.148524.1</td>
<td>Ext/Pub</td>
<td>Release 11.5- How To Setup a PTO Plan and the Elements for This Plan</td>
</tr>
<tr>
<td>Note.256391.1</td>
<td>Ext/Pub</td>
<td>Unable to Query Accrual Plan In Form but Still In Table</td>
</tr>
<tr>
<td>Note.274144.1</td>
<td>Ext/Mod</td>
<td>For Accrual Plans Where Is The Plan End Date Set</td>
</tr>
<tr>
<td>Note.265051.1</td>
<td>Ext/Pub</td>
<td>Creating Pto Accrual Plan And Can Not Add Entry Value To Element</td>
</tr>
<tr>
<td>Note.269117.1</td>
<td>Ext/Mod</td>
<td>PTO Accrual Plan has stopped Accruing for 'some' employees</td>
</tr>
<tr>
<td>Note.268171.1</td>
<td>Ext/Mod</td>
<td>How Do We Stop Accrual Plans From Going Negative -</td>
</tr>
<tr>
<td>Note.263972.1</td>
<td>Ext/Pub</td>
<td>Pto Plan Element Entries Do Not Get Processed During Payroll Run</td>
</tr>
<tr>
<td>Note.259280.1</td>
<td>Ext/Pub</td>
<td>Cannot Change the Priority Field on PTO Plan if using Formula PTO_PAYROLL_BALANCE_CARRYOVER</td>
</tr>
<tr>
<td>Note.260071.1</td>
<td>Ext/Pub</td>
<td>PTO Carry Over Processes Employee that is Not Enrolled in Plan</td>
</tr>
<tr>
<td>Note.264658.1</td>
<td>Ext/Pub</td>
<td>PTO Plans Error With Invalid Number When Run During Payroll Process</td>
</tr>
</tbody>
</table>

Notes on Accrual Plans

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.264658.1</td>
<td>Ext/Pub</td>
<td>PTO Plans Error With Invalid Number When Run During Payroll Process</td>
</tr>
</tbody>
</table>
### Notes on Setup

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.148524.1</td>
<td>Ext/Pub</td>
<td>Release 11.5 - How To Setup a PTO Plan and the Elements for This Plan</td>
</tr>
<tr>
<td>Note.277031.1</td>
<td>Int/U.E</td>
<td>R11.5 - Setup an Earnings Type Element to be Used to Capture PTO in Oracle Time Management.</td>
</tr>
<tr>
<td>Note.146721.1</td>
<td>Ext/Pub</td>
<td>R11.5 - Setup an Earnings Type Element to be Used to Capture PTO in Oracle Time Management.</td>
</tr>
<tr>
<td>Note.270192.1</td>
<td>Ext/Mod</td>
<td>Accrual Fast Formula Correction Wipes Out Prior Accrual Setup</td>
</tr>
</tbody>
</table>

### Notes on Formulas

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.275756.1</td>
<td>Ext/Pub</td>
<td>Where to Find Information on Paid Time Off (PTO) and Creating Formulas</td>
</tr>
<tr>
<td>Note.269869.1</td>
<td>Ext/Mod</td>
<td>General Questions On Seeded Formulas</td>
</tr>
</tbody>
</table>

### Notes on Reset

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.294413.1</td>
<td>Ext/Pub</td>
<td>How to Get Employee Accruals to Reset at the Beginning of the Year</td>
</tr>
<tr>
<td>Note.263589.1</td>
<td>Ext/Pub</td>
<td>PAYWSDAP- Trying to Change the Balance Reset Date Receives APP-PAY-0610 Error.</td>
</tr>
<tr>
<td>Note.262045.1</td>
<td>Ext/R.R</td>
<td>How to Reset Negative Carry Over Numbers to Zero</td>
</tr>
<tr>
<td>Note.272133.1</td>
<td>Ext/Mod</td>
<td>How To Get Around Using A Balance Reset Date That Does Not Throw An Error</td>
</tr>
<tr>
<td>Note.264011.1</td>
<td>Ext/Pub</td>
<td>How to Reset The PTO Accrual Balances for Checks &amp; Deposit Advices</td>
</tr>
</tbody>
</table>

### Notes on Balances

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.260389.1</td>
<td>Ext/Pub</td>
<td>The Vacation Amount on SOE &amp; View Accruals does not Balance to the Check/Deposit Advice.</td>
</tr>
<tr>
<td>Note.263589.1</td>
<td>Ext/Pub</td>
<td>PAYWSDAP- Trying to Change the Balance Reset Date Receives APP-PAY-0610 Error.</td>
</tr>
<tr>
<td>Note.261494.1</td>
<td>Ext/Pub</td>
<td>Do I still run the Carryover if I'm using ITD Balances?</td>
</tr>
<tr>
<td>Note.261765.1</td>
<td>Ext/Pub</td>
<td>Where is the balance for the accrual plan element stored</td>
</tr>
<tr>
<td>Note.261057.1</td>
<td>Ext/Pub</td>
<td>PTO CARRYOVER RUN BUT NO CARRY OVER BALANCES CREATED</td>
</tr>
<tr>
<td>Note.277022.1</td>
<td>Ext/Pub</td>
<td>APP-PAY-07717-This element input already being used to maintain an absence balance</td>
</tr>
<tr>
<td>Note.272133.1</td>
<td>Ext/Mod</td>
<td>How To Get Around Using A Balance Reset Date That Does Not Throw An Error</td>
</tr>
<tr>
<td>Note.264011.1</td>
<td>Ext/Pub</td>
<td>How to Reset The PTO Accrual Balances for Checks &amp; Deposit Advices</td>
</tr>
<tr>
<td>Note.261385.1</td>
<td>Ext/Pub</td>
<td>What does Selecting a PTO Balance Type at the Business Group do?</td>
</tr>
<tr>
<td>Note.263598.1</td>
<td>Ext/R.R</td>
<td>CHECK FOR ENTITLEMENT BALANCES ACROSS THE CALENDAR YEAR IN A PAYROLL PERIOD</td>
</tr>
<tr>
<td>Note.261501.1</td>
<td>Ext/Pub</td>
<td>PTO Carryover is Not Rolling over Balances</td>
</tr>
<tr>
<td>Note.264844.1</td>
<td>Ext/Pub</td>
<td>How Does the PTO_SIMPLE_MULTIPLIER or PTO_SIMPLE_BALANCE_MULTIPLIER Work?</td>
</tr>
<tr>
<td>Note.250385.1</td>
<td>Ext/Pub</td>
<td>Accrual Carry Over Elements Increase Prior Years Balance</td>
</tr>
<tr>
<td>Note.259280.1</td>
<td>Ext/Pub</td>
<td>Cannot Change the Priority Field on PTO Plan if using Formula PTO_PAYROLL_BALANCE_CALCULATION.</td>
</tr>
<tr>
<td>Note.258166.1</td>
<td>Ext/Pub</td>
<td>PAYWSACV - Vacation Balance is Not Correct in the View&gt; Employee Accruals Form</td>
</tr>
<tr>
<td>Note.260518.1</td>
<td>Ext/Pub</td>
<td>PAY_US_PTO_ACCRUAL.NET_ACCRUALS PACKAGE Does Not Return Correct Balances</td>
</tr>
</tbody>
</table>
Almost Everything you Wanted to Know about PTO - Paid Time Off

Notes on Elements

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.277993.1</td>
<td>Ext/Pub</td>
<td>Pto Elements Are Not Shown On Ss Payslip</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.261273.1</td>
<td>Ext/Pub</td>
<td>PTO Carry Over Completes with a Warning / No Carry Over Elements Created</td>
</tr>
<tr>
<td>Note.261768.1</td>
<td>Ext/Pub</td>
<td>How Does Payroll Read the Carryover Elements Effective Date</td>
</tr>
<tr>
<td>Note.277164.1</td>
<td>Ext/Pub</td>
<td>What Shadow Elements are Created when I 'Save' my Accrual Plan</td>
</tr>
<tr>
<td>Note.148524.1</td>
<td>Ext/Pub</td>
<td>How Does Payroll Read the Carryover Elements Effective Date</td>
</tr>
<tr>
<td>Note.250385.1</td>
<td>Ext/Pub</td>
<td>Accrual Carry Over Elements Increase Prior Years Balance</td>
</tr>
</tbody>
</table>

Notes on Absences

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.290332.1</td>
<td>Ext/Pub</td>
<td>Problems With Replaced By And Absence Reason Fields</td>
</tr>
<tr>
<td>Note.259922.1</td>
<td>Ext/Pub</td>
<td>Absence Element Not Deleted from Element Entry When Absence is Deleted</td>
</tr>
<tr>
<td>Note.276949.1</td>
<td>Ext/Mod</td>
<td>App-Pay-07717-This element input already being used to maintain an absence balance</td>
</tr>
<tr>
<td>Note.277022.1</td>
<td>Ext/Pub</td>
<td>Please Verify LOV For Absence Type And Accrual Category For US Legislation</td>
</tr>
<tr>
<td>Note.255936.1</td>
<td>Ext/Mod</td>
<td>PTO Element Created Is Not Using Same Termination Rule As Absence Taken</td>
</tr>
<tr>
<td>Note.264749.1</td>
<td>Ext/Mod</td>
<td>How To Enter An Absence For Actual Date After The Payroll Has Been Processed</td>
</tr>
<tr>
<td>Note.270139.1</td>
<td>Ext/Pub</td>
<td>How do I get the Absence Start/End fields to be displayed in Bee</td>
</tr>
<tr>
<td>Note.263007.1</td>
<td>Ext/Pub</td>
<td>How To Enter An Absence For Actual Date After The Payroll Has Been Processed</td>
</tr>
<tr>
<td>Note.257877.1</td>
<td>Ext/Pub</td>
<td>How to get Accruals to Calculate on Inactive Assignments (i.e.Unpaid Leave of Absence)</td>
</tr>
<tr>
<td>Note.251005.1</td>
<td>Ext/Pub</td>
<td>'Vacation' Choice not in Lov for Absence Types Window</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.269393.1</td>
<td>Ext/Mod</td>
<td>PTO Element Created Is Not Using Same Termination Rule As Absence Taken</td>
</tr>
<tr>
<td>Note.260066.1</td>
<td>Ext/Pub</td>
<td>BEE Transfer Process Ends as Incomplete with Message About the Absence Duration of Time</td>
</tr>
</tbody>
</table>

Notes on Payroll Issues

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.266825.1</td>
<td>Ext/Pub</td>
<td>Payroll Process or Quick Pay Error after Applying Patch 3364019 or 3330030 / 3549170</td>
</tr>
</tbody>
</table>
Almost Everything you Wanted to Know about PTO - Paid Time Off

General PTO Notes

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.267289.1</td>
<td>Int/U.E</td>
<td>Almost Everything You Wanted to Know About PTO REFERENCE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note.260552.1</td>
<td>Ext/Pub</td>
<td>Understanding PTO changes (Accrual changes) since HRMS PF_D</td>
</tr>
<tr>
<td>Note.284552.1</td>
<td>Ext/Pub</td>
<td>PTO For Suspended Assignments Not Calculating Correctly</td>
</tr>
<tr>
<td>Note.263586.1</td>
<td>Ext/Pub</td>
<td>THE PTO CARRYOVER COMPLETING BUT NOT UPDATING.</td>
</tr>
<tr>
<td>Note.281649.1</td>
<td>Ext/Pub</td>
<td>PTO Accruals For Both Vacation &amp; Sick Time Are Not Accurate</td>
</tr>
<tr>
<td>Note.281514.1</td>
<td>Ext/Pub</td>
<td>PTO Accrual Starting Over for Employees When Link Criteria Changes, why?</td>
</tr>
<tr>
<td>Note.278406.1</td>
<td>Ext/Pub</td>
<td>Understanding PTO changes (Accrual changes) since HRMS PF_D</td>
</tr>
<tr>
<td>Note.281273.1</td>
<td>Ext/Pub</td>
<td>PTO Carry Over Processes Employee that is Not Enrolled in Plan</td>
</tr>
<tr>
<td>Note.261385.1</td>
<td>Ext/Pub</td>
<td>What does Selecting a PTO Balance Type at the Business Group do?</td>
</tr>
<tr>
<td>Note.260213.1</td>
<td>Ext/Pub</td>
<td>PTO For NON-EXEMPT IS DISPLAYING ON DEPOSIT ADVICE AS NEGATIVE</td>
</tr>
<tr>
<td>Note.148524.1</td>
<td>Ext/Pub</td>
<td>R11.5 - Setup an Earnings Type Element to be Used to Capture PTO in Oracle Time Management</td>
</tr>
<tr>
<td>Note.270630.1</td>
<td>Ext/Pub</td>
<td>Date Earned Not Showing For PTO Element</td>
</tr>
<tr>
<td>Note.266619.1</td>
<td>Ext/Pub</td>
<td>Costing PTO For Salaried Employees Doubles - Reduce Reg Is Not Costed</td>
</tr>
<tr>
<td>Note.274562.1</td>
<td>Ext/Pub</td>
<td>PTO Vacation Does Not Accrue Correctly</td>
</tr>
</tbody>
</table>

Sherri Harley HRMS

5/24/2011
From Note 294548.1 - Always ask these questions when working on PTO issues

Goal
The below questions will hopefully help you get to a faster resolution when working PTO issues.

Fix
1. What Family Pack is the Customer on?
2. What is the versions of pyusptoapkh/pkb and peaclical.pkh/phb
3. What is the Payroll Balance Reset Date selected? (located on the Accrual Plan Form)
4. What is the name of the Accrual Formula the Accrual Plan is using?
5. Is the customer using the seeded versions or a modified version of the seeded formula?

These questions are needed when logging a bug against the PTO product